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Microsoft Windows 2000 gives you control over your computer and your resources. From finding class materials on the Internet by using the powerful Search Assistant to working efficiently on a portable computer, Windows 2000 has the features you need to get your work done without hassles and hang-ups. Windows 2000 is reliable, secure, and easy to maintain. Features such as Windows File Protection and support for the latest hardware help to circumvent potential problems, enabling you to devote your energy to what you do best.

In this hands-on session, you will:

· Search your hard disk and the Internet for resources you need.

· Set up and use Offline Files on your portable computer so that you have access to network and Internet resources wherever you are. When you are not connected to your network, you can open Offline Files and make changes to them, and then automatically update the network with your changes when you re-connect.

· See how easy Plug and Play makes it to hook up new hardware to your computer. Just plug in the hardware and Windows 2000 does the rest.

· Learn to make the most of your portable computer by setting up multiple dial-up connections with the Dial-Up Connection Wizard.

· Set up power management options for your laptop to conserve power and warn you when your battery is low.

· Discover how accessibility features and personalized menus can make your onscreen presentations more effective.

· Learn how Windows File Protection automatically repairs the system when a key file is missing.

If you have used Windows before, you will find Windows 2000 easy to learn. It combines the easy-to-use features of Microsoft Windows 98 with the reliability and security of Microsoft Windows NT. If you are new to Windows, take a tour of Windows 2000 by clicking Discover Windows on the Getting Started with Windows 2000 screen that appears the first time you start Windows 2000. If you do not see the screen when you start Windows, insert the Windows 2000 CD-ROM, click Start, point to Programs, point to Accessories, point to System Tools, and then click Getting Started.
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Touring Windows 2000 Professional

Before you start using Windows 2000, become familiar with its features. The following illustration shows the Windows 2000 desktop including the Start menu and some of the icons you might see:



Using Windows 2000 Professional

Imagine that tomorrow morning you are going to give a history lecture. You plan to hook up your portable computer to a projection system in the classroom so that you can show some photos and Web sites to support your points. Between now and then, you need to get all of your materials together and set up the room. Fortunately, Windows 2000 Professional makes preparing for your multimedia lecture fast and easy, and tomorrow it will all go smoothly.

Finding the Resources You Need

For the lecture, you need some current information about an archeological dig and you know you can find it on the Internet. You also want to reuse some lecture notes from 1998 that you archived on your hard drive somewhere. Next, you want to send an e-mail message to a student teacher who may want to attend your lecture, but you cannot find her address.

The Windows 2000 Search Assistant makes it easy to search for files and folders, people, and other computers on your network or the Internet. The Search Assistant also uses the Windows 2000 Indexing Service, which creates an index of the files, folders, and Web Content in Internet Information Services, making searching even faster.

When you search for files, you can specify several search criteria such as the file name, type, and size. In addition, you can search for specific text in files; for example, if you cannot remember the exact name of those missing lecture notes, you can search on archeology. Note, however, that searching for text takes more time.

To search for files or folders

1. Click Start, point to Search, and then click For Files or Folders.

2. In the Search for files or folders named box, type all or part of the name of the file or folder you want to find. You can use an asterisk (*) as a wildcard character to represent one or more characters; for example, if you cannot remember the name of the file, but you know it is a Microsoft Word document, you can type *.doc.

3. To search for specific text in a file, in the Containing text box, type the text you want to find.

4. In the Look in list, click the drive, folder, or network you want to search.

To specify additional search criteria, click Search Options, and then click one or more of the following options to narrow your search:

· Click Date to look for files that were created or modified on or between specific dates.

· Click Type to look for files of a specific type, such as a text or Microsoft WordPad document.

· Click Size to look for files of a specific size.

· Click Advanced Options to specify additional search criteria.
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5. Click Search Now.

When you search the Internet, you can narrow your search by choosing a category. Categories allow you to search for everything from Web pages to people’s addresses to maps. In addition, you can search for specific text on the page. For example, you can search for a Web page that contains the words ancient Rome.

To search the Internet

6. Click Start, point to Search, and then click On the Internet.

7. Under Choose a category for your search, click the category you want to search. Click More to see additional search categories.

8. Type your search criteria, and then click Search.

9. If you do not get any results, try removing some of the search criteria to make your search more general. To clear the search criteria fields and begin a new search, click New ([image: image2.bmp]).

10. In the list of search results, click a link to display the Web page.

When you search for people, you can search a number of different places, including the Windows Address Book, the Windows 2000 Server Active Directory directory service, and many Web sites such as MSN and Yahoo! People Search. In addition to searching for a particular name, you can specify other criteria. For example, if you do not know how to spell the last name of the student teacher you want to find, you can specify that the last name contains Anders. This ensures that both Anderson and Andersen are found.

To search for people

11. Click Start, point to Search, and then click People.

12. In the Look in list, click the location you want to search.

13. On the People tab, type a name, an e-mail address, or both.

14. If there is an Advanced tab, you can use it to define further criteria for your search.

Using Offline Files

You have found all of the resources you need, and you want to use them during your lecture, but you cannot be connected to the network or the Internet from the classroom. You can use Offline Files to continue to work with network files and programs. Offline viewing makes entire Web pages with graphics available offline so that you can view them even when you do not have an Internet connection. You can even make changes to your files, and then use the Synchronization Manager to update the network versions. Microsoft Internet Explorer 5.0 has offline viewing features, but with Windows 2000 Offline Files, you can make any network item available offline.
To make files and folders available offline

15. In My Computer or My Network Places, click the shared network file or folder that you want to make available offline.

16. On the File menu, click Make Available Offline.

17. In the Offline Files Wizard, specify how often and when you want the item to be synchronized. For example, you can set files to be synchronized every time you log on or off a computer.
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To open offline items

18. Disconnect from the network or undock your portable computer.
When you disconnect from the network, an Offline Files icon ([image: image4.bmp]) appears in the status area, the rightmost part of the taskbar.

19. Double-click the network drive that contains the items you want to make available offline. The symbol on the icon for an offline item indicates that the item is available for offline use ([image: image5.bmp]).

20. You can open and change the offline items just as you would if you were connected. In addition to your local files, you will be able to see network files that you made available offline and any files that you created after disconnecting from the network.

Note
If your network uses the IntelliMirror functionality of Windows 2000 Server, you can make your entire My Documents folder available for offline use so that you can log on from any Windows 2000–based computer and access your files.

To synchronize offline items

If your offline items are not set to synchronize automatically, you can synchronize them manually.

21. Dock your portable computer or reconnect to the network.

22. In Windows Explorer, on the Tools menu, click Synchronize.
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23. In the Items to Synchronize dialog box, select the check boxes beside the offline items that you want to synchronize, such as a mapped network drive or an Internet Explorer offline Web page.

24. Click Synchronize.

Customizing Your Desktop to Work Efficiently

Not everyone arranges their desk the same way or stores their pens in the same drawer. With Windows 2000, you can customize your desktop in the following ways:

· Put shortcuts to the programs you use most on the Quick Launch bar on the taskbar. Then you can just click the shortcut to open the program.

· Use Personalized Menus, a feature that adapts the Start menu to the way you work by showing the applications you use most often and hiding those you have not used recently. This is similar to the way the menus in Microsoft Office 2000 work.

· Add an Address bar to the taskbar or the desktop, making it convenient for you to type an Internet address or network location without opening Internet Explorer first.

These settings are specific to the current user profile. If you share a computer with someone else, you and the other person maintain custom settings in separate user profiles.

To customize the Quick Launch bar

· In My Computer or Windows Explorer, click the icon for the program you want to add, and drag it to the Quick Launch portion of the taskbar.
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The icon for that program appears next to the other Quick Launch icons on the taskbar.

To turn on Personalized Menus

25. Click Start, point to Settings, and then click Taskbar & Start Menu.

26. On the General tab, select the Use Personalized Menus check box.

To display the Address bar on the toolbar

· Right-click an empty area on the taskbar, point to Toolbars, and then click Address.
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To customize the Start menu

27. Click Start, point to Settings, and then click Taskbar & Start Menu.

28. On the Advanced tab, under Start Menu Settings, select or clear the check boxes for the options you want to turn on or off.

	This option
	Does this

	Display Administrative Tools
	Adds the Administrative Tools menu to the Programs menu.

	Display Favorites
	Adds the Favorites menu to the Start menu.

	Display Logoff
	Adds a Logoff command to the Start menu.

	Expand Control Panel
	Displays the Control Panel menu contents in a list instead of a window.

	Expand My Documents
	Displays the My Documents menu contents in a list instead of a window.

	Expand Network and Dial-up Connections
	Displays the Network Dial-up Connections menu contents in a list instead of a window.

	Expand Printers
	Displays the Printers menu contents in a list instead of a window.

	Scroll the Programs menu
	Displays the contents of the Programs menu in a scrolling list instead of columns.


Making Your Onscreen Materials Easier to See

When you are delivering a lecture to a large group, you can make the material you are presenting on-screen easier to see by using accessibility features like Microsoft Magnifier and High Contrast mode. Magnifier enlarges a portion of the screen for easier viewing, so you can focus the students’ attention on a portion of the screen or show them minute details. High Contrast improves screen contrast with alternative colors and font sizes. To find out more about accessibility features for Microsoft products visit http://www.microsoft.com/enable.

To use Magnifier

29. Click Start, point to Programs, point to Accessories, point to Accessibility, and then click Magnifier.

30. In the Magnifier Settings window, select the settings you want, and then minimize the window.

31. You can click and drag the Magnifier window to make it float, and you can resize it by dragging the window border.

To use High Contrast

32. Click Start, point to Programs, point to Accessories, point to Accessibility, and then click Magnifier.
33. In the Magnifier Settings window, select the Use High Contrast mode check box, and then minimize the window.
Hooking Up Hardware to Your Computer

When your lecture is prepared and it is time to present it, the last things you want are hardware incompatibilities. Do not worry, because Windows 2000 features Plug and Play technology. Just plug in a device and Windows 2000 does the rest by installing any necessary drivers, updating the system, and allocating resources. That means you can simply walk into a lecture hall, plug your portable computer into a projection system, and you are ready to go!

To hook up new hardware

34. Connect the device to the appropriate port or slot on your computer, according to the device manufacturer's instructions.

35. If prompted, follow the instructions on the screen to choose a destination path to install drivers for the device.

36. Depending on whether the device is Plug and Play–compatible or is an older device, you may need to start or restart your computer.

Working As a Mobile User

As an educator, you teach and make presentations in many environments: classrooms, lecture halls, libraries, auditoriums, and so on. You probably prepare for classes in as many places. It is no wonder more and more educators are relying on portable computers to take their materials from place to place. Windows 2000 enables you to set up multiple dial-up connections with the Dial-Up Connection Wizard so that it is easy to connect to the Internet, your network, or another computer from wherever you are, without having to reconfigure your settings.

Power Options are also key Windows 2000 features that make mobile computing easy. Using Power Options, you can conserve power by setting the system to go on standby after a specified period of inactivity and by setting it to hibernate after a longer period. In standby mode, Windows reduces the amount of power your computer consumes. In hibernate mode, Windows saves everything in memory to your hard disk, and then turns off the computer. When you turn the computer on again, Windows restores your desktop exactly as you left it. Power Options also allows you to set an alarm to warn you when your battery is low.

To set up multiple dial-up connections

Note
You may need additional information to set up dial-up networking. For specific information such as phone numbers and network settings, contact your System Administrator.

37. On the Start menu, point to Settings, point to Network and Dial-up Connections, and then click Make New Connection.

38. In the Network Connection Wizard, follow the instructions to add a new network connection.

39. Repeat steps for each network connection you want to set up.

To configure an existing network connection

40. On the Start menu, point to Settings, and then click Network and Dial-up Connections.

41. Right-click the connection you want to configure, and then click Properties.

42. Do one or more of the following:

· To configure dialing devices, telephone numbers, host addresses, country or region codes, or dialing rules, click the General tab.

· To configure dialing and redialing options, multilink configuration, or X.25 parameters, click the Options tab.

· To configure identity authentication, data encryption, or terminal window and scripting options, click the Security tab.

· To configure the remote access server and protocols used for this connection, click the Networking tab.

· To enable or disable Internet connection sharing and on-demand dialing, click the Sharing tab.

To conserve power when you are not using your computer

43. On the Start menu, point to Settings, and then click Control Panel. Double-click Power Options.

44. On the Hibernate tab, select the Enable hibernate support check box, and then click Apply.

If the Hibernate tab is unavailable, your computer does not support this feature.

45. Click the APM tab, click Enable Advanced Power Management support, and then click Apply.

The APM tab is unavailable on Advanced Configuration and Power Interface (ACPI)-compliant computers. ACPI automatically enables Advanced Power Management, which disables the APM tab.

46. Click the Power Schemes tab. In the System standby list, click a time. In the System hibernates list, click a time.

[image: image9.png]PowerScheres | lams | Foner Mot Advanced| Hiemate | 474 |

this computer. Note that changing the setings below il macily

2 \i Selectthe power scheme it the mast appropiate setings for
the selected scheme.

Power schemes

Saveds. Delete

Setings for Fortable/Laptop power scherme.

vz ey R (F) (G

Tunoffmontor —[after 5mins v [Aterzmins 7]

Tun oftharddisks: ~ [after 30mins v [After3mins 7]

Systemstandby:  [after 20 mins

[After § mins

System ibemates:  [Never =] [Never <

[ Cancel Apply





To set a warning alarm for a low or critical battery condition

47. On the Start menu, point to Settings, and then click Control Panel. Double-click Power Options.

48. On the Alarms tab, under Low battery alarm and Critical battery alarm, specify the settings you want by dragging the slider.
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49. Click Alarm Action to select the type of alarm notification and power level you want, and then click OK.

Windows File Protection

You take your portable computer home to work on next term’s curriculum and you find out the next morning that your nephew was playing with it and he deleted a couple of key system files. Windows File Protection protects core system files from being deleted or overwritten. If a file is deleted or overwritten, Windows File Protection replaces that file with the correct version. By safeguarding system files in this manner, Windows 2000 mitigates many common system failures found in earlier versions of Windows.

Important

The following procedure requires you to remove a key system file that Windows will then replace. Follow the instructions carefully.

To test Windows File Protection

50. In Windows Explorer or My Computer, display the contents of the C drive, open the WINNT folder, and open the System32 folder.

51. Select the Accwiz.exe file, and then click Delete. This moves the Accessibility Wizard file to the Recycle Bin.

52. Attempt to run the Accessibility Wizard by clicking Start, pointing to Programs, pointing to Accessories, pointing to Accessibility, and then clicking Accessibility Wizard. Windows File Protection replaces the file, and the wizard runs.

53. To verify that Windows File Protection replaced the file in the C:\Winnt\System32 folder, display the contents of this folder and look for the Accwiz.exe file.
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54. To see a report on the actions by Windows File Replacement, click the Start button, point to Settings, and then click Control Panel. Double-click Administrative Tools, and then double-click Event Viewer. Click System Log in the Tree pane. The Windows File Protection event is at the top of the list. Double-click this event to read the event details.
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Educator Tutorial Series





What you will do:�


Search for files, Web sites, and people�


Set up, use, and synchronize Offline Files�


Customize your desktop �


Use Accessibility features to make on-screen presentations more visible�


Hook up hardware�


Create dial-up connections�


Use power management options for a portable computer�


Learn about Windows File Protection�





Words to know:�


Accessibility Features—Features that help people with disabilities, such as blindness and deafness, use the computer.�


Dial-Up Connection—�A network or Internet connection through a telephone line. �


Local Area Network (LAN)—A network spread over a relatively limited area, such as an office.�


Offline Files—Network and Internet files that you can access even when you are disconnected from the network and the Internet.�


Power Options —A set of features that minimize the amount of power your computer uses when it is inactive.�


Synchronization—A process in which Windows updates the network with changes you have made to offline items. �


Virtual Private Network (VPN)—A set of nodes on a public network, such as the Internet, that use encryption technology to keep communications amongst themselves private.�


Wide Area Network (WAN)—A network that connects geographically separated areas. The Internet is an example of a WAN.�
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�


If your network is using Active Directory, you can easily search for a printer that is near your location. Active Directory is part of Windows 2000 Server.�





�


If you want to find information on the Internet quickly, you can type go, find, or ? followed by the text you for which want to search, in the Address bar of Internet Explorer.�








�


If you use Microsoft Outlook as your e-mail program, you can search for a specific message, contact, or appointment by clicking Start, pointing to Search, and then clicking Using Microsoft Outlook.�





�


If your network is using IntelliMirror, you can have constant access to all of your information and software, whether or not you are connected to the network. IntelliMirror is part of Windows 2000 Server.�





�


If the Quick Launch bar is not displayed, right-click an empty area on the taskbar, point to Toolbars, and then click Quick Launch.�





�


If you have students who speak English as a second language, or if you teach a second language, consider using the Windows 2000 Multilanguage Version. This version enables you to set menu items and dialog boxes to display in other languages. If you are interested in this version, contact the Microsoft offices nearest you for more information.�





�


For more information about a specific item in a dialog box or on a tab, right-click the item, and then click What's This?�





�


Depending on the type of connection you are configuring, different options appear. For example, a local area connection displays only the General tab.�
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